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Disclaimer
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About the Product

The Output Tool version 2 brings a new dimension to gINT Output, by allowing you to batch output
reports from an easy to use interface - significantly improving workflow and efficiency.

Key Features:
1 Configure and output (PDF, Raster, Preview or Print) multiple reports grouped by Key Set
(PointID, Sample etc), by each Report, or by Range Filter (such as geology code/unit)
Work with single and multiple gINT projects
Most gINT output options are configurable

Multiple configurations may be saved and recalled, and may be stored in the Project, Library,
User (current user on local PC), or Computer (all users on local PC); Further, configurations
maybe imported and exported to XML

Assign User Report Variable values to all reports in a configuration
Improved Range Filter configuration

The enhanced PDF Bookmark grid allows you to define dynamic multi-branch hierarchies; The
options include Key Set, Report Information and Range Filter information

Increment figure numbers

GDW Export allowing for the output of multiple reports to one page

Example Usage

Output a non-cored log, cored log, and photo report grouped by PointID
Output all lab test reports in a database grouped by Sample/Specimen
Output numerous reports configured independently, with incrementing figure numbers

Output multiple graph frames to one page

= =4 =4 -4 -4

Output multiple lab summary graphs grouped by Geotechnical Unit

You need to complete the installation procedure (see Installation and Licensing on page 1) and validate
a license (see Datgel Product Licensing System User Guide) before you can use the Output Tool.

Support

12 months support and maintenance is included with the license purchase. For technical support
please email support@datgel.com or call +61 2 8202 8600.

System Requirements

gINT
The product runs optimally using gINT 8.2.007 (equivalent to 8.1.2.007) or higher.

The product will run using gINT Logs, gINT Logs Plus, and gINT Professional.

Output Tool gINT Add-In Datgel
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Hardware and Operating System

Same system requirements as gINT 8.2, see: http://www.qgintsoftware.com/products_requirements.html.

Required Windows Components

1. Windows Installer 3.1
2. .NET 3.5 Framework SP1

Conventions and typography used in this guide

Note: Tips and additional Information to help you.

Bold Text

Italics Emphasis

CAPITALS

KEY+KEY

Code Snippet

Code sample

File name or path

Table_Name

Field Name

Command line

Used to indicate a series of menu commands.
e.g. Select File > Open.

Used to indicate a gINT Application Group, Application, Table Group or Table , e.g.

DATA DESIGN | Project Database

Items you must select, command buttons, or items in a list.
e.g. Navigate to UTILITIES | Convert Projects (4" tab).

Use to emphasize the importance of a point such as parameters.
e.g. Data Entry i Check Omit Must Save prompt when save is required

Names of keys on the keyboard. for example, SHIFT, CTRL, or ALT.

Key combinations, for example CTRL+P, or ALT+F4.

Indicates a code snippet within a paragraph

Indicates a sample program codes inserted in user guide e.g.

public override string ToString ()
Used for formatting file name and paths e.g. di_lib.glb
V:\ 10 gINT \ Datgel Install Files \

Database table name, e.g. POINT_TABLE

Database field name; e.g. PointID

or

Command line, presented exactly as it must be entered e.g.

cdir

Output Tool gINT Add-In
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Field Colours

Each of the fields in the project tables have been coloured to improve the data entry process as
indicated below in Table 1.

Table 17 Field Colours

Field

Colour

Field Name and Explanation

Yellow

gINT Key Field i mandatory data entry

Pastel Purple

AGS Data i data associated with the AGS Data
Interchange Format

Pastel Green

Calculated Field i data is written to this fieldbyDat g e
code

Data Entry Field 7 data should be entered into this field,

Pastel Beige or data in this field influences the calculation

Pastel Red Legacy Data Field 7 historic data entered here, is
typically from an old database

Pastel Blue Output Option i used to control how data displays on a

report

Pastel Orange

Remark or Metadata Field i additional data associated
with the primary information

Grey

Read-only

Output Tool gINT Add-In
User Guide
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1 Installation and Licensing

1.1 Installation Overview

There are three parts to the installation process:

91 Install DLL programs
1 Merge gINT library objects
9 Validate the product license

The steps must be performed in this order and the first two steps are described below. The validation
procedure must be done last and is described in the Datgel Product Licensing System User Guide.

1.2 Package Contents
Your software purchase may have come with the following contents:
1 Applications CD which normally has the following folders:
\ gINT Files

\ Documentation
\ Installation files

1 A hardware license key

1.3 Before Installation
A few basic preparations can help ensure an effortless installation.
1 Make sure that the computer where you plan to install the program meets the minimum
hardware and software requirements.
1 Connect your PC to the Internet before installation (must have a working Internet connection).

The Output Tool requires that the Microsoft .NET 3.5 framework is installed on the PC prior to
the installation of the Tool. If your PC does not have the .NET 3.5 framework installed, then it
will be automatically downloaded and installed during the Tool installation process.

Log into the PC with Administrator privileges before starting installation.
It is recommended that you exit out of other applications that maybe running on your PC.

Close gINT before you start installation.

= =4 =4 -4

Keep the serial number and license number handy.

1.4 Install DLL Programs

1. If you received an installation CD, then insert the CD and browse to the folder
\Installation Files

2. Double click the file named Setup.exe
3. Click Run to begin installation.
Follow the on screen instructions when installation begins:

4. Click Next on the Welcome to the Datgel Output Tool Setup dialog.

Output Tool gINT Add-In T Datgel
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ﬁ Datgel Cutput Tool EI =] @
Welcome to the Datgel Output Tool Setup Wizard -~

The installer will guide you through the steps required to install D atgel Output Tool on your computer.

WARNING: Thiz computer program iz protected by copyright law and international reaties.
Unauthorized duplication or distribution of this program, ar any portion of it, may result in severe civil
aor criminal penalties, and will be prazecuted ta the maximurn extent pozszible under the law.

Cancel { Back

5. Scroll and carefully read the License Agreement, and choose option | Agree, and click Next.
ﬁ Datgel Cutput Tool EI =] @
License Agreement .
Flease take a moment to read the icense agreement now. If you accept the terms below, click "l
Agree’. then "Mext". Otherwise click "Cancel™.
LICENSE AGREEMENT -
Terms and Conditions
This End User License Agreement relates to the program information and
data relating to the Product. The Licensor is Datgel Pty Ltd (ABN 31 116
883 731) (Datgel).
PRODUCTS
| Do Mot Agree @ | Agree
| Cancel | | < Back | [ Tt > l
Alternatively choose | Do Not Agree and click Cancel if you disagree with the license
agreement. The installation will stop and exit.
6.

On the Select Installation Folder dialog, either accept the default folder (recommended) or
select Browse to specify the folder where you want to install the Output Tool.

Leave Everyone bulleted to indicate that anyone logged onto the PC can use the Output Tool.
Click Next when ready.

Output Tool gINT Add-In i Datgel
User Guide
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ﬁ Datgel Cutput Tool EI = @

Select Installation Folder ¥

The installer will install Datgel Output Tool to the following folder.

Toinstall in this folder, click "Mext". To install to a different folder, enter it below or click " Browse""

Foalder:

C:%Program Files\D atgelsD atgel Output Tool Browse...

Install Datgel Output Tool for yourself, or for amyone who uses this computer:

@ Ewveryone

0 Just me

[ Cancel l ’ < Back l [ Mewt > l

OPTIONAL Click on Disk Cost to view the disk space statistics. Click OK when done.

‘_'E Datgel Cutput Tool Disk Space @

The ligt below includes the drives you can install Datgel Output Tool to, along with each diive's
avallable and required disk space.

Wolurne Digk Size: Available Rec
= 102GE RAGE -
=0 7395ME 11EEME r
=IE: 1588mME 1325MEB

2 M: OB kB

=N 418GE 188GE

20 418GE 188GE =
< I 3

7. Click Next to start installation.

ﬁ Datgel Cutput Tool EI = @

Confirm Installation ¥

The installer iz ready to install Datgel Output Tool on your computer.

Click "Mes=t" to start the installation,

Cancel l ’ < Back l [ Pt

Datgel

Output Tool gINT Add-In T
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8. Observe the progress bar to monitor installation progress

ﬁ‘ Datgel Cutput Tool EI =] @

Installing Datgel Output Tool b

Datgel Output Tool is being installed.

Please wait...

9. When the Installation Complete dialog is displayed you have the choice to initiate the merging
of gINT library objects after you click close by checking the Merge gINT Library and Project
Objects check box. Click Close.

j’_{‘;’ Datgel Cutput Tool o] = =]

Installation Complete u

Datgel Output Tool has been successfully installed.

Click "Close" to exit.

tderge glMT Library and Project Objects
Flease use Windows Update to check for any critical updates to the MET Framewark.

Cancel ¢ Back

1.5 Merge gINT Library Objects

Note: If Stepl.5hasal ready been compl eted by Dat gel dhenpdoecece| oper s,
to section 1.6 Validate License.

If you have not merged the current version of the library objects on your current Computer, then the
Datgel Output Tool gINT Obiject Installer form will display. Conversely, if you have previously merged
the gINT Library objects the form will not appear; you will be prompted to open gINT, and should
proceed to section 1.6 Validate License.

The gINT Object Installer can also be called from Windows Start > All Programs > Datgel > Datgel
Output Tool gINT Object Installer.

Output Tool gINT Add-In i Datgel
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R Datgel Output Toel gINT Object Installer

[= (&=

| File Help

Library Objects

MName Description

Datgel Output Tool gINT Add-In ...
. Gint Rules Modules Datgel Qutput Tool gINT Rules M...
. Qutput Reports Libra... List of Reparts

aINT Library E|
Selection Options |Select All
[ chek |
gIMT Library and Project/Data Template files must not be open at the
time of installation.
Before the installation, a time stamped . zip file of the gINT Library

and Project/Data Template files will be made in the same directory as
the gINT Library and Project/Data Template files respectively.

oINT Executable Path | ¢:\program Files\gINT3 bin\gints. exe |£|

Install

=N

Select gINT Library and Project/Data Template files and click Install

1. Ensure you have gl NT cl osed,

2. Click on the gINT Library browse button [+ and

open

your companyéo6s

wish to use with the Output Tool. A backup zip of your custom library will be made in the same

folder.

3. Click Install. The new library tables will be copied to your library file, and other library objects

will be merged via a gINT script.

1.6 Validate License

After installation (and before using the Output Tool), validate the user license as described in Chapter 3

of the Datgel Product Licensing System User

Guide.

Note: You only need to validate this product when you run the Datgel Output Tool in gINT for the first time.

Output Tool gINT Add-In T
User Guide
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2  Using the Tool

2.1 Overview

Select INPUT | Add-Ins > Datgel Output Tool > Datgel Output Tool to launch the tool.

The Tool has two tabs, General and Reports.

The general tab allows for configuration of global / general options, such as Configuration Type, Data
Source, Key Set, Filter, Range Filter, Output options, and general user report variable settings.

14 Datgel Output Tool o )
Configuration Report Help
5 kol ke Location: Project Configuration: = | @
Table: IN_SITU_CER Field: Paste
General | Reports
Configuration Type Range Filter
(%) Group By Key Set () Report () Group By Range Filter ‘ cave | ‘ Save As | |0pen/Edit\ ‘ Clear |
Data Source Range
() Current Single Project Table Name
Top Field Name
(Z) Mon-Current Single Project Bottom Field Name
Indude Top/Bottom
O Muitiple Project Criteria Field Name
Description
Key Set Table MName
Source Table povT Criteria Field Name
Description Field Name
Generate Range Filter Criteria |
Filter
Z-=A | | |Descnpﬁon | |
Sort 1 (]
Sort2 O
1 2 [E 4 5
Field
Criteria Output
Or () Preview () Print (Z) Exportto POF () Export to Raster
Or
Al T File [+ [ open [Jsient
i i PDF Bookmarks
Replace User Report Variable Text Resalution (dpi) |00 ‘ | ookmar ‘
| [user Report varizble [ place Holder | Replace Text Expression | [ POF Individual Datasets
|i| [C] overwrite PDF
Execute | [ Reeer 3 | Cancel

Output Tool gINT Add-In i
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The Reports tab allows for the configuration of an unlimited number of reports, and optionally you may
set report specific filters and other settings.

{4 Datgel Output Taol [E=R[E=H >0
Configuration Report Help

Z kbl kA Location: Project Configuration: S | @
Table: |POINT Field: Paste

General || Reports

Drag a column header here to group by that column E]

| |Gruup |ReportType ‘ReportName |Remark |Key Set ‘Usar Report Variable |F\Iber |Ranga Filter Report Options GDW Page No. Counter Increment |
L]

Execute | ‘ Reset | ‘ Cancel
2.2 Menus and Toolbar

Configuration Report Help

= b Ed Location: Project Configuration: A7
Table: Field: Paste

2.2.1 Configuration Menu

]
1 =~ Open/Edit Configuration (Ctrl+O): Initiates the Open Edit sub form, used to edit or
delete existing configurations, and select an existing configuration

1 = Save Configuration (Ctrl+S): Save configuration

i H Save Configuration As (F12): Save configuration as a new name, and define a
description

1 Configuration Location: The storage location of the current Configuration. You may open a
Configuration then save it in a different location

1 Settings Configuration: Combo box that allows you to select an existing name or type a new
name

= . . , :
7 B Export Current Configuration to XML (Ctr+E): Export the current form configuration to
an xml file; Enables simple interchange of configurations e.g. via email

= &
1 _F] Import Configuration from XML (Ctrl+l): Import an xml file storing a configuration

1 = Set PDF Initial Folder (Ctrl+P): Set a default initial folder for the pdf and raster file
browse. Stored on the current PC for the current user

Output Tool gINT Add-In T Datgel
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2.2.2
T

2.2.3

2.25

2.3

Report Menu
o Populate All Reports (Ctrl+R): Clears the Reports grid and lists all reports in the current
library

74 Reports Grid - Clear Filter and Sort (Ctrl+F): Removes the user defined filter and sort
from the Reports grid, and returns the Reports grid to the order that will be used for output

= Reports Grid i Save Current View (Ctrl+G): Sets the current reports Grid View as the
default and it will now be used for Output. That is, the current sort and filter is permanently
applied and any hidden rows will be deleted

= Update Reports Captions and Source Table (Ctrl+U): Initiates the configuration form for
report captions and source table, and updates the list of reports

Help Menu

L7 Help (F1): Initiates the online help, and where applicable is context sensitive

About Datgel Output Tool: Displays version and copyright information about the product

Data Tool

Table: List of project tables
Field: List of fields in select project table

Paste: Pastes select table and field to the Filter group in the format [Table].[Field]

Buttons

Execute: Initiates the output run, Ctrl + Execute will display the gINT Script in a text reader
and give you the option to save the file

Reset: Clears the form and restores defaults

Cancel: Closes the form

Configuration Type

The Configuration type defines how the output will be grouped. Three configurations exist:

1

2.4

Group By Key Set: Outputs all rows in the Reports grid for each Key Set listed in the Key Set
group on the General tab. A Key Set could be a PointID or Sample etc. Hence this option
could be used to print many reports for BH1, then many reports for BH2 etc.

Reports: Outputs all the Key Sets listed in the Key Set group on the General tab for each
Report listed in the Reports tab. Hence this option steps through the Reports grid, and outputs
the configuration defined on the current reports grid row, or if the field is empty then it uses the
value on the General tab.

Group By Range Filter: Outputs all the reports for each range filter checked in the General
tab Range Filter group. Hence for the first checked range filter criteria, all reports will be
output, then the second check range filter will have all reports output, etc.

Data Source

Three data source options are available:

T

Current Single Project: The current project open in gINT INPUT

Output Tool gINT Add-In i Datgel
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1 Non-Current Single Project: Browse to open a different project to that currently open in gINT
INPUT

1 Multiple Project: Define multiple projects in a grid. The first project is used to define the table
and field lists, and to store project level configurations

2.5 Save and Open Configuration

User defined form configurations may be saved and recalled. Refer to section 2.2.1 Configuration
Menu for a definition of each command and tool bar button.

2.5.1 Storage Location
Configurations may be stored in 5 locations, the first 4 are defined by the Location combo box in the
toolbar, and XML is imported and exported via commands in the Configuration menu:
1 Project: Stored in a project file and available to all users of that project file. The project file
used is dependent on the data source:

1 Current Single Project: The Configuration is stored in the current project file

1 Non-Current Single Project: The Configuration is stored in the non-current project

1 Multiple Project: The Configuration is stored in the first project listed in the multi project
grid

Library: Stored in the current library, and available to all users when using any project file
Computer: Stored on the local computer, and available to all users of that computer

User: Stored on the local computer, and available to only the current user

= =4 =4 =

XML: XML files storing configurations may be imported and exported via the Import
Configuration from XML (Ctrl+l) and Export Current Configuration to XML (Ctr+E)
commands. This allows for easy transfer of configurations via email

2.6 Key Set Group

Select the Source Table that contains the Key Sets (e.g. POINTor the Hole ID list) by clicking on the v
button to display the list of available source tables.

Key Set

Source Table o)'s5 E|

1AG,514]4]|C|4|GRAG,514]4.08]|C|4.08|LCCC, 51415.711C]5. 7ILPDN, 514(5.75]IC15. 75IGRAG [+

The Key Sets can then be selected by clicking on the ] button to display the Key Set Selector form.

Output Tool gINT Add-In T Datgel
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[ Key Set Selector [E=nE=R ===
Available Key Sets Selected Key Sets
@ Hole ID | Top ‘ Sample Reference Sample Type Specimen Depth Specimen Reference |7 B Hole ID ‘ Top | Sample Reference Sample Type Specimen Depth Spedmen Reference ‘ | @
E] e 25.8 c 25.5 GRAG @ e 2.6 c 22,6 DF
B || 328 26 C 26 LCCC E I 514 0.89 o 0.89 GRAG B
328 27 C 27 Lcce 514 4 o 4 GRAG
@ ] 328 7.2 C 27.2 ROCK @ m 514 4.08 C 4.08 LCCC @
] 328 7.5 C 27.5 GRAG ] 514 5.7 C 5.7 LPDN
] 328 27.56 C 27.56 LCCC ] 514 575 o} 5.75 GRAG
|| 328 2.9 C 28.9 RPLT | | 514 6.76 o 6.76 LLPL
|| 328 29.25 C 29.25 RPLT | | 514 6.76 o 6.76 LLIN
7328 29.31 C 29.31 LCCC =
] 328 29.6 C 29.6 ROCK
] 328 1.83 C 183 DF
] 328 14.76 C 14.75 DF
|| 328 16.44 C 16.44 DF
|| 328 19.03 C 19.03 AF
T 328 24.09 C 24.09 DF
] 328 27.08 C 27.06 DF T
] 328 29 [ 29 ROCK %
[ [#][X] Record 196 of 198 (][I ]] W [ ] [ (3] Record 9 o 5 [ e

The Key Sets are then selected from the Available Key Sets grid and then by clicking on the B button

to select individual Key Sets or by clicking on the @ button to select all the Key Sets. The Selected
Key Sets grid displays the chosen Key Sets.

To remove a Key Set from the Selected Key Sets grid you can remove individual ones by clicking on

that Key Set and then clicking on the E button or you can remove them all by clicking on the @
button.

If the Configuration Type is set to Key Set, then you may reorder the Key Sets using the up and down

arrows @/B/B/@.

2.7 Filter Group

The Filter function works in a similar manner as the gINT OUTPUT Filter. The program automatically
ensures a space is entered after the operator and before the value, and single quotes are placed
around text and # around dates. ( e . dA.0L,i>k &, >#@BLHEH2009#).

Filter
- A
Sort 1 | [POINT]. [HOLE_STAR] ]
Sort2 | D
1 2 | 3 |4 5 & 7 &

Field [POINT]. [Elevation] [POINT].[HOLE_STAR]

Criteria |>= 20 »= #01/03/2009%

Or

Or

Or
£ ” 1]

Output Tool gINT Add-In i Datgel
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2.8 Range Filter Group

The Filter function works in a similar manner as the gINT OUTPUT Range Filter with the exception that
the tables/fields are selected from a drop-down list that has been automatically populated with a list of
the table and field names in your project file, and the criteria range is picked from the populated list.

The generic range filter configuration in the vertical grid may be saved and recalled to/from the current
library.

Range Filter
| Save | | Save As | |Open,|'Edit | | Clear unit
Range
EGEOLOGY_PROJECT_LINIT
Top Field Mame Depth
Bottom Field Name GEOQL_BASE
Indude Top/Bottom Top
Criteria Field Name GEOL_GEDZ2
Description
Table Mame GEDZ
Criteria Field Name Itemkey
Description Field Mame Description
| Generate Range Filker Criteria |
Criteria Description | Output |
3 Surficial Dune Sand and Sandplain
] 2 Holocene Sediments ]
| 3ai Ashburton Red Beds (Soils) - Sandy Clay and Clayey Sands
| Faii Ashburton Red Beds (Soils) - Sand and Silty Sand []
BEe Ashburton Red Beds {Weak Rocks) ]
| 4 Carbonate Rocks ]
| Glauconitic Rocks
Range

1 Table Name: Project table that stores the range data; Normally a PointID,Depth table holding
Geotechnical Unit or Lithology data

1 Top Field Name: Field in the Range Table that stores the top depth of the range; Normally
Depths set

Bottom Field Name: Field in the Range Table that stores the bottom depth of the range

Include Top/Bottom: Defines if Top, Bottom, Both, or Neither are to be included in the range.
If left blank, Bottom is used; We recommend Top

91 Criteria Field Name: Field in the Range Table that stores the criteria or code value

Description (Optional)

1 Table Name: Project table that stores the description of the criteria. Normally an ltemKey table

9 Criteria Field Name: Field in the Description Table that stores the Criteria or code; Typically
ItemKey

Output Tool gINT Add-In T Datgel
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1 Description Field Name: Field in the Description Table that stores the Description
Other
1 Generate Range Filter Criteria: Populates the grid with criteria based on the Range and
Description tables and fields configuration
1 Output Column: Check the criteria you wish to output

Range Filter Configuration

9 Save: Save current range filter vertical grid configuration to the name listed name combo box
Save As: Save the current range filter vertical grid configuration to a new name
Open/Edit: Mange range filter configurations i change name, description and delete

Clear: Clearsthever ti cal grid and critedcoafigugaiond, doesnbt

= =4 =4 =

Name combo box: Select a configuration or type a new hame

2.8.1 Steps to define a range filter

1. Define Range items i Table Name, Top Field Name, Bottom Field Name, Include Top/Bottom,
Criteria Field Name

2. Optionally, define Description items i Table Name, Criteria Field Name, and Description Field
Name

Click Generate Range Filter Criteria
Check the Output box for the Criteria you wish to output

2.9 Output Group

The Output function works in a similar manner as the gINT OUTPUT Export to File and Print options.
Output option specific guidance is provided below:

1 Preview and Print: No output tool settings apply. Note that gINT can associate a printer with

eachreportusingREPORT DESI GN | File > Set Printer for Re

1 Exportto PDF:

1 Resolution (dpi): This property allows you to specify the Resolution, in dots per inch (dpi),
of the PDF file that you are creating with the PDF Export command

1 PDF Individual Datasets: Exports a separate PDF file for each Key Set and Report
Combination. Only applicable to Group by Key Set

1 Overwrite PDF: If the PDF file exists then it will be overwritten

1 Open: Open file after export

Qutput

() Preview () Print (*)Exportto PDF () Export to Raster
File E| open [ silent
Resolution (dpi) 600 PDF Bookmarks |
[ POF Individual Datasets | LSVEl 1 |Key Set

[ ] cwerwrite POF

Output Tool gINT Add-In i Datgel
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1 Export to Raster:

1 Resolution (dpi): Resolution of Raster image in dpi

1 Scale size (%):This will stretch or compress the image as per the supplied value

1 Crop: If marked, the image will be cropped upon export; Cropping will eliminate all white
space around the image leaving just a one pixel wide white border

1 Colour Depth: Don't pick True color just because you think it is better. Image file size
goes up dramatically as you work down the above list. If you don't have color on your
drawing, select Monochrome. If you just use the standard 32 colors that are shipped with
gINT, the 16 color option will work. Only use the other options if you have created your
own colors and are using them on the output or you are making use of the Scale size (%)

option.
Qutput
() Preview () Print () Export to POF
File [ [] silent
Resolution {dpi) |300 File Mame Suffix |

Scale Size (%) Level 1 |Key Set [+]

Colour Depth [ Crop

True Calor {24 Bit) (v

1 General

9 Silent: The error log form at the end of the output run will not display

2.9.1 PDF Bookmarks and Raster File Name Suffix

This group allows you to configure the PDF bookmark hierarchy or Raster File Name, with the option for
an unlimited number of branches.

In the case of Raster Export, the file name defined in the File text box is used, followed by a
concatenated list of items from the File Name Suffixgr i d s epairbat ed by

For each branch you may pick from the following list, some options are Configuration Type specific:

Key Set

PointlD

ProjectID - PointID

Report Name: Field on Report tab grid

= =4 =4 -4 -4

Report Caption: Defined by Output Tool > Reports > Update Reports Captions and
Source Table command, see section 2.12 Update Reports Captions and Source Table

Report Type: Field on Report tab grid
Remark: Field on Report tab grid
Group: Field on Report tab grid
Group - Remark

Report Name - Report Caption
Report Type - Report Name

= =4 =4 A4 -4 -—a -

Report Type - Report Caption

Output Tool gINT Add-In T Datgel
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1 Range Filter Criteria
1 Range Filter Description

1 Range Filter Criteria - Description

2.10 Replace User Report Variable Tex t

The Replace User Report Variable group allows you to globally configure User Report Variables, and
define Place Holders that may be added to User Report Variables which at output time will be replaced
by the Replace Text Expression.

Replace User Report Variable Text

Iser Report Varliable Place Holder | Replace Text Expression
Auto Counter Start 4
Drawing Sub Title Mew Area
Drawn PMWY
i [[Auto Counter 1]]

Auto Counter Start [[Add Desc]] - PRELIM

a Initial Figure Mumber
Project Client

T |Project Title
Project Location
Project Mumber
Drawing Title

The order of replacement of User Repost Variables is:

1. User Report Variable
2. User Defined Place Holder
3. System Place Holder

Hence you may refer to System Place Holders in User Place Holder Replace Text Expressions,
and refer to System Place Holders and User Place Holders within User Report Variable type
replacers.

2.10.1 User Report Variable Replacers

The User Report Variable column has a lookup list containing System values (described in the following
table), and all User Report Variables from all reports in the current library.

System User Report Description
Variable Replacer

Auto Counter Start Enter a number in Replace Text Expression. Overrides the auto counter for report rows,
useful to start figure numbers at a number other than 1/a/A

Initial Figure Number Allows the user to set a global value for the Initial Figure Number text box in the top right
of the gINT OUTPUT Screen.

The value for a User Report Variables listed in the Replace User Report Variable grid is replaced with
the Replace Text Expression.

The User Report Variable field on the Reports tab must be populated with the gINT script syntax text in
order for this to work.

Output Tool gINT Add-In i Datgel
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2.10.2 Place Holders

You may enter special text strings into User report Variables that will be replaced when you click
Execute. System Place Holders allow for incrementing of figure or page numbers. User Defined Place
Holders could be used to append a string on the end of an existing User Report Variable Value, set a
drawn by name or drawn date etc.

Note:

Place holders are case sensitive

Replace text expressions that contain a comma must be surrounded in double quotes, e.g.:
A<<ListBuildSepTrim( - [[Groupl]], [[Report Type]], [[Report Name]], [[Caption]],

[[Remark]], [[Key Set]], [GDW Page No.]])>> 0
2.10.2.1 System Place Holders

The following place holder within User Report Variables will be replaced when the user clicks Execute
during the script generation.

Place Holder Description

[[Auto Counter 1]] Report grid item number, 1 based

[[Auto Counter A LC]] Similar to above, except this will return lower case letters.

[[Auto Counter A UC]] Report grid item number converted to an upper case letter, 1 based. Will return A to
ZZ,e.q. 30" report grid row will return AD.

[[Caption]] Reports grid column

[[Counter Increment]] Reports grid column

[[Current URV]] Current user report variable value in the reports grid field for current Name, or the value

set in a preceding row in the Replace User report Variable grid

[[Current URV.<URV Name>]] Current user report variable value in the reports grid field for <URV Name> Name, or
the value set in a preceding row in the Replace User report Variable grid

[[GDW Page No.]| Reports grid column

[[Group]] Reports grid column

[[Key Set]] Reports grid column

[[Range Filter Criteria]] Current rage filter criteria code, only applicable to Group by Range Filter
[[Range Filter Description]] Current rage filter description, only applicable to Group by Range Filter
[[Remark]] Reports grid column

[[Report Name]] Reports grid column

[[Report Type]] Reports grid column

2.10.2.2 User Defined Place Holders

You can define custom place holders to replace text in User Report Variable rows. The place holder
may be surrounded by text within a row.

Output Tool gINT Add-In T Datgel
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2.10.3 Example Usage

Replace User Repart Variable Text

|Iser Report Varliable | Place Haolder Replace Text Expression
1 [Auto Counter Start 4
E Drawing Sub Tite Mew Area
? Drawn PMW
T Initial Figure Mumber [[Auto Counter 1]]
5 [[Add Desc]]  -PRELIM
#

This example does the following:

Sets the Auto Counter Start to 4, so the first figure number will be Figure 4

2. For all reports listed in the Reports tab, the value for User Report Variable named Drawing Sub
Title will set to New Area

3. For all reports listed in the Reports tab, the value for User Report Variable named Drawn will
set to PMW

Sets the Initial Figure Number for each report to the Auto Count Incrementing Number

Replaces sub-strings [[Add Desc]] within the User Report Variable for all reports with the string
T PRELIM

After setting the configuration in the Replace User Report Variable Text group, move to the Reports tab
and for all reports in the grid do the following:

1. Click on the User Report Variable edit button for a row

LIser Report Variable |
<ARRAY =Draning 1|

2. Place the text [[Add Desc]] at the end of the Drawing Title value, highlighted in the red box.

Note how there is no space before [ [ifdesired and
no empty spaces will be applied

= User Report Variables @

Hame Value
Drawing Title ROCK DRY DENSITY ¥S ELEVATION[[Add Desc]]

Drawing Sub Title
Scale Text N.T.S.
Paper Size A4
Drawn
Reviewed or Authorised IEAutn Counter 1uAutn Counter A U[Zuhulu Counter A L[Zm
Date Reviewed or Authorized
Plate Type | FIGURE
Plate Prefix
Plate Sub Mumbering Type |4

Plate 5ub Mumbering Start

Colour | -1

Revision Number |

oK Cancel Print Export Help

Output Tool gINT Add-In i
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Note the System Place Holders highlighted in the blue box
3. Click OK

4. Apply the place holder to other reports

2.10.4 Example Usage of Current URV
Replace User Report Variable Text grid
User Report Variable: Drawing Title

Replace Text Expression:
"[[Current URV.Scale Text]], [[Current URV.Drawing Title]], [[Current URV]], WHOLE SITE"

Example Output

AS SHOWN, BULK DENSITY VS ELEVATION, BULK DENSITY VS ELEVATION, WHOLE SITE

2.11 Reports

The Output Tool utilises any reports that exist within your gINT library file. Settings defined on the
Reports tab take precedence over General tab settings.

Refer to section 2.2.2 Report Menu for a definition of each command and tool bar button.
The Report grid columns are:

Group: A meta data field, can be used as a PDF bookmark or in Replace Text Expression
Report Type: gINT report Type, e.g. Log
Report Name: gINT report name, e.g. Non-Cored Borehole

Remark: A meta data field, can be used as a PDF bookmark or in Replace Text Expression

= =4 =4 -4 -2

Key Set: Combination of key fields, e.g. PointID, or PointlD,Depth. The source table for the
current report is defined by Output Tool > Reports > Update Reports Captions and Source
Table command (see section 2.12 Update Reports Captions and Source Table), or in the
source table on the General tab is used as a default.

1 User Report Variable: Clicking on the =) will display the native gINT User Report Variable
form. You can set the values as required, including the use of Place Holders.

9 Filter: Clicking on the =) will display the Filter form, configure as required and click OK. The
Filter function works in a similar manner as the gINT OUTPUT Filter. The code ensures a
space is entered after the operator and before the value with single quotes placed around text
and # around dates. (e.g.#).> O0A6, Like 6BHO, >

1 Range Filter: Clicking on the ] will display the Range Filter form, configure as required and
click OK. See section 2.8 Range Filter for an explanation.

1 Report Options: Clicking on the L) wil display the Report Options form, configure as
required and click OK. This is applicable to graphs only; other report types will have this field
read-only.

Output Tool gINT Add-In T Datgel
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[ Datgel Qutput Teol
Mir
Independent Axis

Dependent Axis

- Report Options

Max

Scale

ok |

| Cancel

1 GDW Page No.: Setting the same value for two or more rows in the reports grid will initiate
those rows to export to the same named GDW page, and then print/preview/export as
configured. For example, if you have a direct shear graph report sheet that requires the
presentation of 3 graph frames on one sheet then set the three graphreport6 s GDW Page
to Direct Shear Comp. If you have a different multi frame sheet in the same reports grid, then

use GDW Page No. Direct Shear Comp A etc.

1 Counter Increment: Defines the increment for Auto Counter System Place Holders.
Normally you would leave this column blank a n d
report that will output multiple pages you would enter the number of pages here, e.g. i 3 0 .
Seeing the Output Tool doe s rkidotv how many pages the report will print, you need to
manually type in the value.

us e

t h ebutdveeh youHateai 1 0

Report grid rows can be reordered by using the arrow controls EI / tl / tl / EI and individual
reports can be removed from the grid by selecting the applicable row in the Reports tab grid and by
pressing the delete key on your keyboard.

Prior to reordering, inserting a row or copy-pasting you will be prompted to either Save the Current

View, or to Cancel and return to the Report grid.

Right click in the grid to Insert a Row or Delete the selected rows.

It is recommended Reports, Source Table, and Caption be defined by Output Tool > Reports >
Update Reports Captions and Source Table command (see section 2.12 Update Reports Captions
and Source Table). The Tool will function without this configuration.

2.12

Update Reports Captions and Source Table

For the Output Tool to function optimally, you should configure the Caption, Source Table, and
Separate Sets for each report using the Output Tool > Reports > Update Reports Captions and
Source Table command.
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-

R4 Datgel Output Tool - Update Report Captions and Source Tables (o= ][==]
Repart Type Repart Mame Caption Source Table | Descri... | Separate Sets -
SiteMapReport  MAP AdL |

| |siteMapReport  MaP AdP |

| rextnoc AGS3 PROJECT SUMMARY [

| | extTbl CONTOUR BASE ]

| rextrol CONTOUR TOP WITH FILTER O

| |Fence FEMCE A1l ]

| |Fence FEMCE A1L MO PLAN ]

[ — FEMCE A1LE []

" |Fence FEMCE A1LE NO PLAN [

| |Fence FEMCE A3L ]

- |Fence FENCE A3L NO PLAN [J ||
" |Fence FENCE A3LE ]

" |Fence FEMCE A3LE NO PLAN []

| |Fence FENCE A4L O 3
| |Fence FENCE A4L MO PLAN ]

| O

Cancel

SNRE|

‘ Get Reports | ‘ Ok |

Upon loading the form you will be ask if new reports should be added. A message box will display
indicating the number of new reports added, if any. Further, the new records will append at the end of
the grid and be highlighted in a Pastel Beige colour.

You should now configure the Caption, Source Table and Separate Sets columns. Refer to the
following for a definition. Click OK to save your changes.

Columns
1 Report Type: List of report types
1 Report Name: List of reports in library
1 Caption: An option for PDF bookmark, raster file name and Replace Text Expression
1 Source Table: Name of the table to be used by the Key Set Selector on the Output Tool

Reports tab. For example, for logs you should set POINTfor a lab report you may choose CLSS
or SPECIMENIf you leave this blank, then the Source Table defined on the Output Tool
General Tab will be used by the Key Set Selector form

Description: Meta data field for a report description, not used in any function of the tool.

Separate Sets: Will cause the generation of a unique script per keyset, only applicable to
Group by Reports

Output Tool gINT Add-In T Datgel
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3

3.1

Example Usage

Group by Key Set 1 Multiple reports for

S| Report Appendix

This example shows the batch output of a non-cored log, cored log, and SPT vs. depth graph grouped
by PointID. This is a common scenario for an appendix of a site investigation report.

{14 Datgel Output Tool (=8B ||
Configuration Report Help
55 el ke Location: Project Configuration: |nan-cored, cored, sptaraph |l @
Table: Field: Paste
General |Reports
Configuration Type Range Filter
(2) Group By Key Set () Report (0) Group By Range Filter = ‘ ‘ e | |ODE”HK‘ ‘ Cear
Data Source Range
(3 Current Single Project EiG
Top Field Name
() Mon-Current Single Project Bottom Field Name
Indude Top/Bottom
() Multiple Project Criteria Field Name
Description
Key Set Table Name

Source Table poINT Criteria Field Name
212,449,479,580,581,582, 583,588,589 [ Description Field Name
Generate Range Filter Criteria |
Filter
- A ‘ ‘ Criteria | Description | Cutput |
Sort 1 O
Sort2 O
1 2 [3 4 5 5
Field
Criteria Output
or () Preview (O Print (2) Export to POF () Export to Raster
or
<] [ ] File [) GJopen [Jsient
i PDF Bookmarks
Replace User Report Variable Text Resolution (dpi) |600 oLt ‘
i Level 1 [Key Set v
| | User Report Variable ‘ Place Holder Replace Text Expression | [ POF Individual Datasets
Level 2 [Report Caption
|i| QOverwrite PDF
Execute | ‘ Reset ‘ | Cancel
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u Datgel Qutput Tool EI@
Configuration Report  Help
5 bl b Location: Project Configuration; non-cored, cored, spt graph ¥ | @
Table: Field: Paste
General || Reports
Drag a column header here to group by that column @
| Group |ReportTyDe ‘ReportName ‘Rem”. ‘Key |UserReportVar\.u ‘Fil..‘ |Range Fi... Report Opt... GDW Page ... Counter Increment |E]
LA 'Log NON-CORE DRILL HOLE B
Log CORED DRILL HOLE @
Graph AGS3 SPT VS DEPTH <ARRAY>
*
[oeane | [reer ] o
ﬁ group by key set — multiple reports for si report appendix.pdf - Adobe Acrobat Professional E’@
File Edit Wiew Docurment Comments Forms Tools  Advanced “Window Help ®
= - L o .
@G Fm A E S @ RN IRE DD
— 3 T oy _—— .
Tl = NENEEE N NEVER . R &® 5% - = (] Find -
[

®

Options ~

EHE 212

[¥] NON-CORE DRILL HOLE
EHE 449

[£] CORED DRILL HOLE
=8 580

[£] NON-CORE DRILL HOLE

[¥] CORED DRILL HOLE

[E] AGS3 SPT V'S DEPTH
EHE 551

[

[¥] NON-CORE DRILL HOLE

[£] CORED DRILL HOLE

[F] AGS3 SPT VS DEPTH
=8 582

[£] NON-CORE DRILL HOLE

[¥] CORED DRILL HOLE

[E] AGS3 SPT V'S DEPTH
= 53

[¥] NON-CORE DRILL HOLE

[£] CORED DRILL HOLE

[F] AGS3 SPT VS DEPTH
=4 588

[£] NON-CORE DRILL HOLE

[¥] CORED DRILL HOLE

[ AGS3 SPT VS DEPTH

= 539

[¥] NON-CORE DRILL HOLE
[£] CORED DRILL HOLE
[£] AGS3 SPT Vs DEPTH
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3.2

By Report - All Lab Reports
This example exports a PDF of all reports in the Datgel Lab Tool for a PointlD grouped by Report.

{14 Datgel Output Tool (E=T [N
Configuration Report Help
55 el ke Location: Project Configuration: | All Lab rpts |l @
Table: Field: Paste
General |Reports
Canfiguration Type Range Filter
() Group By Key Set (2) Report (0) Group By Range Filter Save | [Savess | [openfedt] [ dear
Data Source Range
(3 Current Single Project [L2bishbme
Tap Field Name
() Mon-Current Single Project Bottom Field Name
Include Top/Bottom
(U Multiple Project Criteria Field Name
Description
Key Set Table Name
Source Table |gpECIMEN Criteria Field Name
v4ab E‘ Description Field Name
Generate Range Filter Criteria |
Filter
A | [criteria [ esaription [output |
Sort 1 O
Sort2 O
2 [3 4 5 5
Field
Criteria Cutput
or ) Preview O print () Exportto PDF () Export to Raster
Or
<] o ] File |P:\Products\.ab ToolImages\2010-02-15 allla rpts.| =] open [ silent
PDF Bookmarks
Replace User Repart Variable Text Resolution (dpi) 600 oA ‘
i Level 1 [ReportType ]
[ Juser Report Varisble | Place Holder | Repiace Text Expression | | PO Indvicual Datasets
Level 2 [Report Name
|i| Overurite PDF
Execute | ‘ Reset ‘ | Cancel

We used the =) All Reports button to populate the reports grid, and then reordered the list.

{4 Datgel Output Teol

(=8 [Ee8 |5

Configuration

Report Help

& bl ke Location: Project

Configuration: | All Lab rpts

TIRE| @

Table:

Field:

Paste

General || Reports

Drag & column header here to group by that column ad B
Group |REpcrtType |REpcrt Name ) |USEr Report ... ‘ |Rang.” ‘Rapcrt‘.. GDW Pa... | Counter Inr... B
Graph LAB ROCK WEIGHT DISTRIBUTION E]
m Graph LAB SOIL ATTERBERG SUMMARY <ARRAY > @
] Graph LAB SOIL CBR PENETRATION
] Graph LAB SOIL CBR PENETRATION MULTI
| | Graph LAB SOIL CBR SWELLING L
| | Graph LAB SOIL CBR VERSUS DRY DENSITY B
| | Graph LAB SOIL COMPACTION
] Graph LAB SOIL CONSOL VOID RATIO SUMMARY <ARRAY >
] Graph LAB SOIL DIRECT SHEAR - COMSOL SQRT
| Graph LAB SOIL DIRECT SHEAR -H ST VS H DISP
| | Graph LAB SOIL DIRECT SHEAR -H ST VS V ST
| | Graph LAB SOIL DIRECT SHEAR -C- CONSOL LOG Via... A 1
n Graph LAB SOIL DIRECT SHEAR -C- CONSOL SQRT Via... B
] Graph LAB SOIL DIRECT SHEAR -C- 5H ST %5 H DIS Via... B
| Graph LAB SOIL DIRECT SHEAR -C- V DIS V5 H DIS Va. B
| | Graph LAB SOIL INDEX PROPS SUMMARY <ARRAY>
| | Graph LAB SOIL PSD 10 PER PAGE SUMMARY ASTM <ARRAY >
m Graph LAB SOIL PSD 10 PER PAGE SUMMARY BSI <ARRAY >
] Graph LAB SOIL PSD 20 PER PAGE SUMMARY ASTM <ARRAY =
] Graph LAB SOIL PSD 20 PER PAGE SUMMARY BSI <ARRAY >
| | Graph LAB SOIL PSD ASTM
| | Graph LAB SOIL PSD BSI
| | Graph LAB SOIL PSD ENVELOPE SUMMARY ASTM <ARRAY >
] Graph LAB SOIL PSD ENVELOPE SUMMARY BSL <ARRAY >
] Graph LAB SOIL PSD LASER DIFFRACTION
: Graph LAB SOIL SHRINKAGE VOLUMETRIC CURVE =
| Execute | ‘ Reset ‘ | Cancel

The resulting PDF has a bookmark for the first page of each report.

Output Tool gINT Add-In i
User Guide

22

Datgel
DOT-UG-001 - 2.06 - March 2010



) 2000-02-21

all lab rpts.pdf - Adobe Acrobat Professional

=

(@] Object Data Tool

E
i
ED

B

=24
=24

:@CreatePDF'c@ @ @ [ﬁ / . f?

Bookmarks

' B

Graph

[] LAB ROCK WEIGHT DISTRIBUTION

[£] LAB SOIL ATTERBERG SUMMARY

[£] LAB SOIL CBR PENETRATION

[} LAB SOIL CBR PENETRATION MULTI

[E] LAB SOIL CBR SWELLING

[£] LAB SOIL CBR VERSUS DRY DENSITY

[} LAB S0IL COMPACTION

[£] LAB SOIL CONSOL VOID RATIO SUMMARY
[] LAB SOIL DIRECT SHEAR - CONSOL SQRT
[] LAB SOIL DIRECT SHEAR - H ST VS H DISP
[E] LAB SOIL DIRECT SHEAR - H STVS W ST

[¥] LAB SOIL INDEX PROPS SUMMARY

[E] LAB SOIL PSD 10 PER PAGE SUMMARY ASTM
[E] LAB SOIL PSD 10 PER PAGE SUMMARY BSI
[] LAB SOIL PSD 20 PER PAGE SUMMARY ASTM
[£] LAB SOIL PSD 20 PER PAGE SUMMARY BSI
[¥] LAB SOIL PSD ASTM

[ LB sOIL PSD BSI

[E] LAB SOIL PSD ENVELOPE SUMMARY ASTM
[} LAB SOIL PSD ENVELOPE SUMMARY BSI
[E] LAB SOIL PSD LASER DIFFRACTION

[E] LAB SOIL SHRINKAGE VOLUMETRIC CURVE
Hist

[£] LAB SOIL PSD FINES CONTENT HIST
GricText

[] LAB AGG LA ABRASION

[ LAB AGG PD & WA

[} LAB AGG SOUNDNESS ASTM C88

B4 Datgel

827x1169in 4

3.3

This example exports a PDF of lab reports grouped by Key Set.

Group by Key Set

Lab reports

It results in a bookmark for each

specimen Key Set with 6 lab report sheet pages under each book mark. Thisdataset di dnét
for all graph reports.
R Datgel Qutput Tool ===
Configuration Report Help
7 kel k& Location: Project Configuration: | dot simple example Dz | @
Table: Field: Paste
General | Reports
Configuration Type Range Filter
(2) Group By Key Set () Report () Group By Range Filter save | [Savers | [openeat] [ clemr
Data Source e
(Z) Current Single Project L2D=tbne
Top Field Name
() Nen-Current Single Project Bottom Field Name
B Indude Top/Bottom
() Multiple Project Criteria Field Name
Description
Key Set Table Mame
Source Table |speCIvEN Criteria Field Name
LAB-C-090927-500110. 1| BULK]0. 1,LAB-C-090927-5002]0. 1] IBULKI0. 1,LAB-C-090927-5003) [--] Description Field Name
[ Generate Rangs Filter Criteria |
Fiter
z->A [ Jertera [oesaripton [ouput |
Sert 1 O zone Filter
Sort 2 O [
i 2 B 4 [5
Field
Criteria Output
or () Preview () Print () Export to PDF () Export to Raster
?h w | File P:\Products\Output Tool\Images\Group by Key Sat—la Open [+] Silent
Replace User Report Variable Text Resolution (dpi) 500 EESE ‘
) Key Set
[ [User Report Variable | Place Holder | Replace Text Expression | | O Por mcviduslDatasers | Leve L jKevSe =
Level 2 |Report Type - Repart Name
|i| Overwrite PDF
Bcate | [ Reset | [ cancel
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h Datgel Qutput Tool

Configuration Repert Help

x
Options

E{E] LAB-C-090927-S00110.1][BULKI0.1]
[F] GrfcText - LAB SOIL ATTERBERG
[E] Graph - LAB SOIL PSD ASTM

28] LAB-C-090927-500210.1][BULKI0.1]
[E] GricText - LAB SOIL ATTERBERG
[E] Graph - LAB SOIL PSD ASTM

= F] LAB-C-090927-S003]0.1][BULKI0.1]
[E] GrfcText - LAB MOISTURE CONTENT
[E] GrfcText - LAB SOIL ATTERBERG
[¥] Graph - LAB SOIL PSD ASTM

=& LAB-C-090927-S004]0 1[[BULKI0 1|
[F] GrfcText - LAB SOIL ATTERBERG

5 kol ke Location: Project Configuration: | dot simple example SR @
Table: Field: Paste
General | Reports
Drag a column header here to group by that column @
‘ Group |ReportType ‘RapcrtName ‘Re..‘ |User Report V... | ‘Range..‘ Report Q... GDW Pa... Counter Incre... | E]
GrfcText LAB MOISTURE CONTENT B
GrcText LAB SOIL ATTERBERG @
GrfcText LAB SOIL MINIMUM MAXIMUM DENSITY
Graph LAB SOIL CBR PENETRATION
Graph LAB SOIL COMPACTION
3 Graph LAB SOIL PSD ASTM
#*
[oeare | [ree ] [conem
'@ group by key set - lab reports.pdf - Adobe Acrobat Professional E’@
File Edit View Docurment Comments Forms  Tools  Advanced  Window  Help x
= L o P
PP e o as o G NEIRB D
— : M @ @ @ 5 -
OB =] &% 5 /a2 fig &Y e® sx - = - Find .

T

m

[¥] Graph - LAB SOIL PSD ASTM

EE] LAB-C-090927-8005(0.1(|BULK0.1|
[¥] GricText - LAB SOIL ATTERBERG
[¥] Graph - LAB SOIL PSD ASTM

EE] LAB-C-090927-8006(0.1(IBULKI0.1|
[¥] GricText - LAB SOIL ATTERBERG
[E] Graph - LAB SOIL PSD ASTM

E{E] LAB-C-090927-800710.1(|BULKI0.1|
[¥] GricText - LAB SOIL ATTERBERG
[E] Graph - LAB SOIL PSD ASTM

= &] LAB-C-090927-5008(0.1(|BULKI0.1|
[¥] GricText - LAB SOIL ATTERBERG
[¥] Graph - LAB SOIL PSD ASTM

= %] LAB-C-090328-5003(0.1(|BULKI0.1|
[E] GricText - LAB SOIL ATTERBERG

[E] Graph - LAB SOIL PSD ASTM

E ] LAB-C-030928-5010[0.1/|BULKI0.1|
[E] GricText - LAB SOIL ATTERBERG
[¥] Graph - LAB SOIL PSD ASTM
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If you check PDF Individual Data Sets then each Specimen will be exported to its own PDF.

T lab-c-090927-5002_01_bulk_01_.pdf - Adobe Acrobat Professional == rE]

Fild

= lab-c-090927-5003_0.1_bulk_01_.pdf - Adobe Acrobat Professional [ =]=]

Filyf
@ lab-c-090927-5004_0.1_bulk_01_pdf - Adebe Acrobat Professional

[=rErrE=]

Fily
'@ lab-c-090927-5005_0.1_bulk_0.1_.pdf - Adobe Acrobat Professional

[=ErrEz]

Fily

] lab-c-090027-£006_0.1_bulk 0.1_.pdf - Adobe Acrobat Professional

Fil{

T Iab-c-090927-5007_0.1_bulk 0.1 _.pdf - Adobe Acrobat Professional

Fil{

T2 Iab-c-090927-5008_0.1_bulk 0.1_.pdf - Adobe Acrobat Professional

Fil{
@ lab-c-090928-5009 0.1_ bulk 0.1_.pdf - Adobe Acrobat Professicnal

E=EE]

Fil{
@ lab-c-090928-5010 0.1 _ bulk_0.1_.pdf - Adobe Acrobat Professicnal

SEiEE]

(| &g File Edit Wiew Docurment Comments Forms Tools  Advanced  indow  Help *
a - ;
E PP e S a s E S d Y E W D
I Dﬁ_ug\rﬁlu ik &) & & ® s - Bl () | Find
[
[ [ | Bookmarks a2
&
4 1 TIGUID LIWIT, PLASTIC LIMIT AND
g " | Options Lab PLASTICITY INDEX
4 5
E ‘:;ﬁ.;léﬁ"u.‘.. Nﬁ?ﬁ?:" acammae
e o T S B | e E
FERCENTAGE PASSING 023 e TEST SIEVE £3) = et |
[P———— P
PLASTICHT Y INOEX ASTM D 431808 & i |
|
[
(&
5
|
5
| é i ™ 3
9 ¢ e e —{ i
al € E ot PR e e :
4
5
11c¢
L
G
=~ PARTICLE SIZE DISTRIBUTION
Si ke ASTMC 11736 A8 ASTW © 13506
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B ! e TR
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3.4 GDW Export T Group by Key Set - Multiple lab test graphs on
one page

This example outputs 3 graphs to one GDW page/sheet, and PDFs the page. Refer to section 2.11
Reports for an explanation of GDW Page No.

K3 Datgel Output Tool [el=]==]
Configuration Report  Help
5 kel kel Location: [project Configuration: Direct Shear 1Page N 8 AR
Table: Field: Paste
General | Reports
Configuration Type Range Filter
(2 Group By Key Set () Report () Group By Range Filter save | [savess | [openfedt] [ clear
Data Source Range
A:l Current Single Project Table Name
Top Field Name
() Mon-Current Single Project Battom Field Name
B Indude Top,/Bottom
(_) Multiple Project Criteria Field Name
Description
Key Set Table Mame
Source Table || AB SOIL_DIRECT SHEAR Criteria Field Name
V1ablo|IDI0. 112 = Description Field Name
[ Generate Range Filter Criteria |
Filter
> A ‘ ‘ Criteria | Description | Cutput |
Sort 1 O
Sort2 O
1 2 B 4 5 5
Field
Criteria Output
or () Preview () Print (Z) Export to POF () Export to Raster
on
J‘ m ] File |P:\Products|Output Tool Images\GDW Export — Grouy -7 open [ Silent
Replace User Report Variable Text Resoluton (dpl) |00 ‘ [ PoF Booiamara |
| [user Report variable | Place Holder | Replace Text Expression | [ POF Individual Datasets
|i| Overwrite PDF
eae | [ rem | [ ]
4 Datgel Output Tool = B[
Configuration Repert Help
5 bl ke Location: Project Configuration: Direct Shear 1Page S e
Table: Field: Paste
General || Reports
Drag a column header here to group by that column @
‘ Group |ReportType ‘RapcrtName ‘Re..‘ |Ke |U5er Report ... ‘ |Rang..‘ |Report.” GDW Pa... Counter Incre... | E]
» Graph LAB SOIL DIRECT SHEAR -C- CONSOL LOG D51 B
Graph LAB SOIL DIRECT SHEAR -C-SH ST VS HDIS DS1 @
Graph LAB SOIL DIRECT SHEAR -C- V DIS VS H DIS DS1
*
Execute | ‘ Reset ‘ | Cancel
Output Tool gINT Add-In i Datgel
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ﬁ Da tgel DIRECT SHEAR

DATA SOLUTIONS BS1377-7:1990:4.5.4
Gt  eoervimnenet » oborctary STATUS: 2
CLIENT Client 1 LOCATION SAMPLING DATA
ENGINEER  : Engineer 1 DUMP AREA - HOLE ID V-Lab
PROJECT © Construction Project LAYER : HOLE TYPE ™
LOCATION Somewhere, World penc S SAMPLEDEPTH  : 000-1.00m
PROJECT No. - 1234 ELEVATION SAMPLE TYPE 0
LABORATORY - Lab 1 SAMPLE REF 1
SPECIMEN DEPTH : 0.10m
LABORATORY SPECIMEN DESCRIPTION: SPECIMENREF  : 2
Slightly sitty very gravelly well graded SAND (SW) medium to coarse sand, fine to medium gravel SAMPLE DATE
SAMPLED BY LB - Contactor 1

STAGE NUMBER ' 2 3

52007 Dl L Tool

VERTICAL DISPLACEMENT (mm)

"o 05 10 20 25 a0 35 40 a5
HORIZONTAL DISPLACEMENT {mm)

SHEARMHORIZONTAL STRESS (kPa)

o 05 10 15 20 25 a0 35 40 a8
HORIZONTAL DISPLACEMENT (mm)

GENERAL REMARKS: Rem VPRem SDRem Fill Type Reguirement Remark. Tested By Tested Date
_ ] 01/01/2010
A Type 1 Not Applicable
Checked By Checked Date
SPECIMEN PREPARATION TEST METHOD: cB 03/01/2010
BS1377-7:1990:4.5.4 smal shearba - single pre—r T~
st
e AB 04/01/2010
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3.5 Group by Range Filter

This example exports 4 graphs grouped by a range filter Geological Unit.

Replace User Report Variable Text

| [User Report ariable | Place Holder | Replace Text Expressian |

{1 Datgel Output Tool (===
Configuration Report Help
55 el ke Location: Project Configuration: | dot rf example S E| @
Table: Field: Paste
General [Reports
Configuration Type Range Filter
() Group By Key Set () Report (%) Group By Range Filter [Save | [Savess | [coenkedit] [ cear |
Data Source Range
® Current Single Project Table Mame GEOLOGY_PROJECT_UNIT
Top Field Name Depth
(2 Non-Current Single Project Bottom Field Name Bottom
Indude Top,Bottom Top
() Multple Project Criteria Field Name Unit
Description
Key Set Table Mame GEOLOGY_PROJECT_UNIT_LIST
Source Table Criteria Field Name Ttemiey
E] Description Field Mame Description
[ Generate Range Filter Criteria ]
Filter
A | [ [citeric__ | Desaiption [ouput [~
Sort 1 O zoneFilter CACA Calcarenitz =
Sort2 m] = CLAY CLAY
L 2 [3 ) E MGR Gravel 3
Field
Criteria Output
or () Preview (O Print () Export to POF () Export to Raster
or
< ﬂ w J File |ducts\Output Tool\Images\Group by Range Filter.pdf E] open [ silent

Resolution (dpi) 600 POF Bookmarks \
[JPOF Incivicual Datasets | L=vel 1 [Range Filter Criteria - Description

Level 2 |Report Type - Repart Name
|i| Overwrite PDF
Execute I { Reset J I Cancel I
{4 Datgel Output Taal
Configuration Report Help
[ kel kA Location: Project Configuration: | dot rf example S E| @
Table: Field: Paste
General || Reports
Drag a column header here to group by that column B
—r— e e e [ |
Graph LAB SOIL ATTERBERG SUMMARY <ARRAY> E]
Graph LAB SOIL PSD ENVELOPE SUMMARY ASTM <ARRAY> E]
Graph LAB MOISTURE CONTENT VS DEFTH <ARRAY>
» Graph LA SOIL DRY DENSITY V5 DEFTH | ZARRAY>
#

Beaute | [ Resst | [ Caneal
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group by range filter.pdf - Adobe Acrobat Professional EI
File Edit Wiew Document Comments Forms Tools Advanced Window Help x

.;_JbereatePDF' ,@Combmeﬁles' @Export' @' ﬁ e /' Forms ~ ‘?' @ObjactDataTool K Ln 'ﬁ % e ﬂ:," E’?
OB 80X e s i Y & 88 2= - o . Find -
|! Bookmarks ®

i e Options ~

W
u EHE] CACA - Calcarenite

B [] Graph - LAB SOIL DRY DENSITY VS DEPTH

EHE] cLAY - CLAY
[¥] Graph - LAB SOIL PSD ENVELOPE SUMMARY ASTM
[E] Graph - LAB MOISTURE CONTENT VS DEPTH

EHE GYPM - Gypsum
[¥] Graph - LAB MOISTURE CONTENT VS DEPTH
[E] Graph - LAB SOIL DRY DENSITY VS DEPTH

=HE] MGR - Gravel
[¥] Graph - LAB SOIL PSD ENVELOPE SUMMARY ASTM
[E] Graph - LAB MOISTURE CONTENT VS DEPTH

=& MSD - Sand
[E] Graph - LAB SOIL PSD ENVELOPE SUMMARY ASTM

[E] Graph - LAB MOISTURE CONTENT VS DEPTH
[£] Graph - LAB SOIL DRY DENSITY VS DEPTH
EHE] MSM - Silt
[¥] Graph - LAB SOIL PSD ENVELOPE SUMMARY ASTM
[E] Graph - LAB MOISTURE CONTENT VS DEPTH

9 patgel S
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4  Tutorials

The tutorials in this section use the example files provided with the Output Tool

1 Project: datgel output tool example 2.00.gpj
9 Library: datgel output tool example lib 2.00.glb

4.1 Output Many Reports grouped by PointID

This example shows the batch output of a non-cored log, cored log, and SPT vs. depth graph grouped
by PointID. This is a common scenario for an appendix of a site investigation report.

1. Select INPUT | Add-Ins > Datgel Output Tool > Datgel Output Tool to launch the tool.

2. Onthe General tab in the Key Set region, click on the ] button to display the Key Set
Selector form.

Key Set
Source Table

=

3. Select the Key Sets 212, 449, 579, 580, 581 and 582 from the Available Key Sets grid and
then click the B button to add them to the Selected Key Sets grid.

ﬁ Datgel Qutput Tool - Key Set Selector E\ = @ ﬁ Datgel Qutput Tool - Key Set Selector EI = @

Available Key Sets Selected Key Sets Available Key Sets Selected Key Sets

Hole ID
212

Hole ID
k| 583
588
589
BH1
BH2
BH3
BH4
BHS
BH&
BH7
BHS b

]

lm“)]

[ [lreen]
O

[+
[

IR
[«EICI)R]
IR
|
EFHHBEE

oK J [ Cancel oK J I Cancel
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4. Remove Key Set number 582 by selecting it in the Selected Key Sets grid and then click on the

button to remove it, alternatively double click on 582.

iﬂ Datgel Output Tool - Key Set Selector EI [=] @ iﬂ Datgel Output Tool - Key Set Selector EI [=] @

Available Key Sets Selected Key Sets Available Key Sets Selected Key Sets
Hole ID @ Hole ID @
212 B 212 B
579 579

Hole ID Hole ID |~
BH112

BH113

||||||}|

B
|

RO
|

k| 583
588

(]
|

EEBEE
|

589 BH114

BET | | 580 E] B | | 580 E]
BE BED BET NED

BEE Zw | |BH117 o

BET WS

BET | |Pe04

BET | |P-g-05

e o

BHG b

&

| oK | | Cancel | | oK | | Cancel

5. Click OK to accept the Selected Key Sets.

6. On the General tab in the Output region, click on the 1] button to launch the file browser.

Qutput

() Preview () Print (“) Export to PDF  (_) Export to Raster
File E open [ ] silent
Resolution {(dpi) (600 PDF Bookmarks |
(] PDF Individual Datasets | LEVel L |Kev Set
[ ] overwrite PDF

7. Inthe file browser window, navigate to a folder that you want to save the PDF file to and enter
the name that you want to call the file in the File Name field.

8. Inthe PDF Bookmarks area, click on the next available field and then click on the button to
display the list of Bookmarks
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